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1 Introduction to Solidworks Commands

2 Applications of 2D Sketch Tools
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Windows and Display

* Cascade

* Arranges all SolidWorks document windows so they overlap with title
bars visible.

* Tile Horizontally — Tile Vertically
* Arranges the open SolidWorks document windows so they are all visible
* Full Screen Mode.

¢ Full Screen Mode hides menus, the status bar, and the Feature Manager design
tree to show more of the graphics area.

F9 — Show/Hide Feature Manager Design Tree
F10 — Show/Hide All Toolbar
F11 — Full Screen Mode

Toolbar

Toolbars are available for most SolidWorks tools, and also for
add-in products.

Named toolbars assist you in performing specific design tasks
such as applying surfaces or drawing curves.

Because the Command Manager contains the most frequently
used tools for the currently selected document, toolbars are turned off
by default.

You can display:
* SolidWorks toolbars
* Toolbars for add-in applications

Introduction on Solidworks

* Solidworks is a solid modelling computer-aided design (CAD) and
computer-aided engineering(CAE) computer program published by
Dassault Systems.

* Solidworks is a Software that contains various tools which helps in
modelling of a component/structure as part or assembly.

User Interface Overview

. Heads-up View Toolbar
. Solidworks Search

. Help Flyout Menu

. Task Pane

. Graphics Area



Windows and Display

* Each document in the SolidWorks application displays in a separate
window.
* Document Window

* In the SolidWorks application, each part, assembly, and drawing is
referred to as a document, and each document is displayed in a
separate window. (Each drawing document can contain multiple
drawing sheets, though.)

* New Window

* Creates a new window, with another view of the original document,
for viewing the active part, assembly, or drawing.

Menu bar

The Menu Bar contains a set of the most frequently used tool buttons
from the Standard toolbar, the SolidWorks menus, the SolidWorks
Search, and a flyout menu of Help.

EERPl 0-e-d-e-9-h-898

Introduction Basics of
Solidworks

User Interface Overview

. Menu Bar

Toolbar

. Command Manager

. Configuration Manager
. Property Manager

. Feature Manager Filter

. Feature Manager Design Tree
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. Status Bar




Property Manager

Title Bar The feature iconQ and feature name (Extrude1, for example) (read-only).

Buttons «* OK i Accept the selections, axecute the command, and close the PFropertyMansgar
M Cancel Igriore any selestions and dose the Propertytanyger.
Gy Preview Displey a preview of the feature,
K& Help Opei the coreesponding Nefp topic.
S Keep Vigible Pur the PropeurbyManager open,
[} Back Rature o the previeus step-.
g Next Proceed ta the next step.
2y Undo Unde the pravieus exwcutions,

Message Atext box directing you to the next step, often listing various ways to implement the next
step.

Group Box Collection of related buttons, list boxes, and selection boxes, with a group title (Direction 1,
for example), which can be expanded or collapsed

Selection Box Accept selectians in the graphics area or in the Feature Manager design tree. When active,
the boxes are pink. When you select an item in the selection box, it is highlighted in the
graphics area. To delete selections from a box, right-click and choose Delete (for one item)
or Clear Selections (for all items).

Feature Manager Filter

The Feature Manager design tree filter¥ets you search for specific
features of parts and components of assemblies.
To filter the Feature Manager design tree:

] At the top of the Feature Manager, in the filter field type a keyword to
display the items you want to view

You can filter by:
* Types of features
* Feature names
* Sketches ¢
« Folders
« Mates
* User-defined tags

Toolbar

In addition, the following special toolbars help you work more
productively:

* Heads-up View tools
* Context toolbars
 Shortcut bars

You can customize:

* Visibility and position of toolbars for part, assembly, and drawing
documents.

* Visibility of context toolbars.
= Tool buttons on toolbars.

Configuration Manager

The Configuration Manager is a means to create, select, and view
multiple configurations of parts and assemblies in a document.

To activate the Configuration Manager:
¢ Click the Configuration Manager tab at the top of the Manager Pane.
* Each configuration is listed separately.

The icons in the Configuration Manager denote how the configuration

was created:
A Manually,

¢ With a design table,
8 Manually, and kas an explode state of 2 derived carfiguration.

™ Wwith 2 design table, and has an expiode state or z derived configuration.



Feature Manager Design Tree

The Feature Manager design tree on the left side of the SolidWorks QW ““""I'c"“<ni“""y5""“>
window provides an outline view of the setive parl. assembly, or drawing, This ® ;@ st
makes it easy to see how the model or assembly was constiucted o to examine ( ill Comments -
the various sheets and views in a drawing. I 32 Matesial <not specifed>
To toggle visibility of the Featura Manager design tree area, press FY of ! ‘Q e
click View > Feature Manager Tree Area. which is especially useful when in - T?P
full sereen mode. ; & R'g.h.t
The Feature Manager design tree and the graphics arca are dynamically 4, Origin .
linked. You can select features, sketches, drawing views, and construction '@ Barude-Thinl
geometry in either pane. I & o
You con split the Feature Manager design tree and either display two k"@s";:l n2
Feature Manager instances, or combine the Feature Manager design tree with the O%E:T: del
Configuration Manager or Property Manager. | T Sketchs
& @* CSK for M8 Flat Head Machine *
|2 Sketehs
| - Sketcha
- B Mirrer

Status Bar

) The status bar at the bottom of the SolidWorks window provides
information related to the function you are performing.

To display or hide the status bar:
* Click View > Status Bar.

Typical information provided in the status bar:
* A brief description as you move the pointer over a tool or click a menu item.
* Sketch status and pointer coordinates, when you are working in a sketch.

* Commonly used measurements for selected entities, such as the length of
an edge.

* A message to indicate that you are editing a part while in an assembly,
* Unit Systen ™% = which shows the unit system for the active document in
the status bar and lets you change or customize the unit system.

Command Manager

The Command Manager is a context-sensitive toolbar that
dynamically updates based on the toolbar you want to access. By
default, it has toolbars embedded in it based on the document type.

When you click a tab below the Command Manager, it updates to
show that toolbar.

StaRacelves Bons Bane . ik (R Frvener v

5 [E] . 4]
Firuced A5 S<ent SennZage Bimaded ol Suage Gt Eife
BessBana S Werard

: @ukd Bout Basa mufud Ca -

Use Ctrl+Page Up and Ctrl+Page Down to scroll through the
Command Manager tabs.

Property Manager

The Property Manager is a means to set properties and
other options for many SolidWorks commands.

The Property Manager appears on the Property
Manager tab in the panel to the left of the graphics area. It
opens when you select entities or commands defined in the
Property Manager. You can choose whether it opens in other |, ..

cases in Tools > Options > System Options > General. ®
- Bbecson 3 CH
“Thin Foammn v




Graphics Area

The graphics area displays and lets you manipulate parts, assemblies,
and drawings.

Contents:

* Reference Triad * Callouts and Handles
* Triad * Viewports

¢ Origin * Image Capture

* Heads-up View Toolbar
¢ Accepting Feature

Triad

The triad facilitates manipulating various objects such as 3D
sketch entities, parts, certain features, and components in assemblies.

The rings and wings are displayed when rotation and dragging
along the wings' planes are possible.

Use commands to display information about the triad or to
change the position and orientation of the triad. Available commands
depend on the triad's context.

Heads-up View Toolbar

A transparent toolbar in each viewport provides all the common
tools necessary for manipulating the view.

CONNE- @604 &
Custom and camera views you define appear on the View @ i
Orientations flyout. ,

Task Pane

The Task Pane provides access to SolidWorks resources, libraries
of reusable design elements, views to drag onto drawing sheets, and
other useful items and information.

The Task Pane appears when you open the SolidWorks software.
It contains the following tabs:

* Solidworks Resources View Palette

* Design Library * Document Recovery
* File Explorer « Appearances, Scenes and Decals
¢ Secarch * Custom Properties

Solidworks forum



Reference Triad

A triad appears in part and assembly documents to help orient you
when viewing models. You can also use it to change the view
orientation. You can hide the triad but you cannot use it as an inference
point. ¥

N

To change the view of Orientation with reference Triad, Do one of the following

Select an axis See the view normal to the screen.

Select an axis that is normal to the screen Change the view direction 180 degrees.

Shift + select Rotate 90 degrees about the axis.

Ctrl + Shift + select Rotate 90 degrees in the opposite direction,

Alt + select Rotute about the axis by the Arrow Keys increment specitied
in Tools > Options > System Options > View

Cirl + Alt + select Rotate in the opposite direction,

Origin

The model origin appears in blue and represents the (0,0,0)
coordinate of the model. When a sketch is active, a sketch origin
appears in red and represents the (0,0,0) coordinate of the sketch.

Dimensions and relations can be added to the model origin, but
not to a sketch origin.
To toggle the origin display:

* Click View > Origins. When the icon next to the menu item is
highlighted, origins are visible (except for origins you have hidden
individually).

Solidworks Search and Help

You can use SolidWorks Search to find information in
documentation and forums. You can also find files and models, and find
and run a SolidWorks command with just a few keystrokes.

Search lets you find and run commands from SolidWorks Search
or locate a command in the user interface.

When you access help, a Web version of the documentation is
displayed in a Web-based view. You can choose to view a local help
(.chm) file, for example, if your Internet connection is slow or
unavailable.

Task Pane

@ SofidWorks Resources  Groups of commands fr Getting Started, '(:mhnumity1 and Online Resources, p' Tip of the Day.

@ Design tihrary Reusable parts, assemblies, and other elements, induding Eibary Features,

E File Explorer Oupicate of Wirdows Explock 01 your compute, ius Recent Documents 2nd Opest in SclidWorks, 1f SoiidWorks Workgroup
POM i added i the o harges 1 L%

E Seditch Resesls of search operatons,

E View Palette Images of siandard wiev}sz aneotation views, section vieks, and flat patterns {sheet meta! pats; to drag oto 3 dmﬁrq sheet.

E Document Recovery I auto-resovery s enabled n Tools » Options > System Options > Backup/Recover and the system terminates anexpestedly,
recovered files appear on thes tab the next time yeu start the application,

b Appearanices, Scenes,  Libeary of appearances, sceres, and decais,
and Decals

E Castom Propeeies  Eker Lstom propestes in Suldierks Ses,

Fsmmwmsmmm Brose the Selidiorks Discussion Forum from directly wihie the Task are,



Viewports

You can view models through one, two, or four viewports.
To open four viewports:

*Click Four 2 View from the Standard Views toolbar
or Windoew > Viewport > Four View. ”

= “fin “Trknwtiie:

Image Capture

Captures the graphics area of the active window or viewport onto
the clipboard.

To capture the screen:

1. Click Image Capture @ (Screen Capture toolbar} or View > Screen Captare > Iimage Capture.
2, Paste the image into another application such as Micrasoft Word, Microsoft PowerPoint, etc.

Accepting Features

You have several streamlined ways to accept features you create,
including right-click actions, using the Confirmation Corner, and using
standard Property Manager commands.

After creating a preview of a feature, you can:
* Right-click and select OK or Cancel from the shortcut menu.

* Right-click when the pointer changes to 3 to accept the preview, or
click to return to the preview without accepting the values

Callouts

Callouts arc text-filled boxes that appear in the graphics area
when you use certain tools. Handles allow you to dynamically click,
move, and set certain parameters without leaving the graphics area.

Callouts help you easily distinguish between different entities.

Callouts

ProfieiShetoni}]




Viewports

You can choose the following viewport arrangements from the Window
menu or the Standard Views toolbar:

Views Displayed
Single View User-specified
Two View - Horizontal Front and Top

Two View - Vertical ~ Front and Right

Four View Front, Right, Top, and Trimetric (Third Angle), or Front,
Left, Top, and Trimetric (First Angle). Specify First
Angle or Third Angle in Tools > Options > System
Options > Display/Selection.

Manager Pane

The left panel of the SolidWorks window manages part and
assembly designs, drawing sheets, properties, configurations, and third
party applications. The Command Manager provides access to the
SolidWorks tools.

Manager Pane Contains,
1. Feature Manager

2. Property Manager

3. Configuration Manager
4. DimXpert Manager

5. Display Manager

Accepting Features

Conformation Corner

Another way to accept features is to use the Confirmation Corner.

+ Click the OK or Cancel icons that appear in the Confirmation
Corner of the SolidWorks graphics area.

* Click the Exit Sketch icon in the Confirmation Corner to finish
the sketch or click the Cancel Sketch icon o discard changes to 88 —
the sketch. i

Handles

The handle color is set in Tools > Options > System
Options > Colors in the System colors box. Active handles are
the Highlight color. Inactive handles are the Inactive Entities color.

Handles span the length of extrusions. Drag the handle to the
desired extrude depth, and the handle spans that length.

You can also drag the pointer (instead of the handle) to the
desired extrude depth. Click the handle, then drag the pointer in either
direction.

Active handl-\“\ r‘;
—

Y



DimXpert Manager

The DimXpert Manager lists the tolerance features ||
defined by DimXpert for parts. It also displays DimXpert

tools that you use to insert dimensions and tolerances

parts. You can import these dimensions and tolerances into

drawings.

Manager Display

You can switch between the Feature Manager design tree, |

Property Manager, Configuration Manager, and Display Manager
by clicking the tabs at the top of the left panel in the SolidWorks
window.
You can split the panel and display more than one manager
or multiple copies of one manager.
Sphttmg the Manager Pane
Mo_vfi the pointer to the top of the Manager Pane until it changes
to=%— .
* Drag the bar down below the last item in the Manager Pane.
Each instance of the Manager Pane displays a set of tabs.
* Sclect a tab for each Manager Pane. ) 5

into

e I
B Pant
4 LA} Annotations

3= Material <nol specified>

%> Front Plane

% Top Plane

&% Right Plarie

1 Ongin

= [ Extrude!
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Display Manager

The Display Manager lists and provides editing access to |

appearances, decals, scene, lights, and cameras that are applied to the
current model. When PhotoView 360 is added in, the Display Manager
provides access to PhotoView Options.

& 8% Scene (Plain White)
&l Lights

& Camera

~h Walk Though
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S.NE Roll No Name ')0‘"‘31}"‘_ q/ﬁ:‘-\ V\‘," ')f}l”‘ﬁ‘” 25\\ 2‘]%‘
e —
1 19ME001 AAKASH DEEP SHAH Zlols V0 07 121 /, Tal <
2 19MEQ02 AKASH P IAVAVEAVEVATrWa Ve ra N
3 19ME003 AKHIL KUMAR.A . rl4 -1l 1T 7 Tal /
4 19ME004 ALSON TONGBRAM Al .l Il Jlalec |, T oo
5 19ME006 ANIL LAMSAL ., VRVAVAVEIE VRV ETE X
6 19MEO07 ANKIT KUMAR M 210/ 00180, 1.1, 1al s
7 19ME009 ARIUN P PEVALIAVAVEVE S Y,
8 19ME010 ARUN PANDIYAN T c VW7 lrlzs00cl, 1, T/ T
9 19ME011 ARUN R 2 M 0,007 1.t/ [alr
10 19ME014 ASHUTOSH KUMAR YADAV W7l Jal T~ o~
11 19MEO015 BALAGANESH.R . ARYRVAVEVIETEVAVE R Y
12 19ME016 BALAJI M mrravarevreEvVEMI Ay
13 19MEO017 BARATH M LV |7 7z ladlr sl lad s
14 19MEO19 BOOPATHI RAJA M s g 72 Vs 1,07 lal, T 7T
15 19ME022 DEVA K ~ s lx s 072 U 07 0,17
16 19ME023 DILDAS P.B sl 1l Wz 1l /7 Tools 4
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27 1SME044 KATHIRVEL D 2 lzlrdal, ToTals 11,
28 19ME045 LOGANAND.J YAV RrSYEVEEE VAV rn Y
29 19ME049 MD FASHIULLAH . Z Vlalz 0 lrirl T ]7 T~
30 19MEO052 MD REHAN RAZA . 7z M, 0172 b7 V70| 07 1, T/
31 19ME054 MITHUN KUMAR . als 7zl 1 072 s |2 /
32 19MEO0S5 MOHAMED ANWARKHAN S Z lalzV 17270 T700F17 § oL
33 19MEO57 MOHAN R s 17l lolsr VT .37 T,
34 19MEO058 MOHANA PRIYA P s 171721, 1ad /1071 Tex
35 19MEO059 MUHAMMED AMEEN , s Wzl l7rlals, 0], 17
36 19ME060 MUTHUVEL G s a7z 0alsl/ /s Tal-
37 19ME061 NAVEENKUMAR A Azl sl 1207 |7 oo
38 19ME063 PRANAV KOLLARA , s Azl 0, 1ab /- Tols T/
39 19ME064 PRANAV PRASANNAN , sz lalrlrsrl lalapnlr] f&
40 19MEQ65 PRATHEESH K VA NEVAVEVAFRETIEE K
41 19ME066 PRAVEEN M a sl 02, 1/, 17 12
42 19ME067 PREMLAL BASKI , S RAVAIIAVIErYA VAR Y,
43 19ME069 RAHUL RAJESH M ¢ lalzi2zl7slals 0, 7 Ta-
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45 19SMEQ74 RANJTHKUMAR R olslAl7l 0087 7 14
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57 19ME093 VIDURSAN M Al T M2 Ll 2l T
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59 1SMEQ95 VINAY KUMAR Ads |l rdels i/ |la il /
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1. Email®

Full Name

2. Full Neme *

Roll Number

3. Roll Numt>er®

Year and Section

4. Year and Section *

= 7 “Section 1

5. Afeature that adds materlal to a part? 1 potnt
Msrk only one oval.

(JHole
) Boss
Tt

Nl 2

IV 1623 hmie Acded Constay
17.  Aloft feature can be a boss only. 1 palnt
Mark ondy one ovsl,

(. _iTue

Cw'_,‘ False

18. You can mirror entities using reference planes and planar faces. 1 pairt

/ Y

\) Mark only one oval.
{)rue
I
.

") False, only lines and Edges can be created

19.  Which is a nota type of pattern in SOLIDWORKS? 1 point

Mark only one aval.

"7 Sketch driven Paitern
(75 Tuble driven Patietn

"y Contintious pattesn

20.  Which tool would.you use to cut 2 hole through the object?  paim

Mark only one ovak

{7 Extrude Cut 9ol
{7 Extrude tool
{3 mimto0! S

3012022, 1623 Vetup Added Cowrse
10.  What is axie? 1 point
Mark only one oval.

£” ) A straight line thist can ke used lo creste model geometiy, features, of patteme.
Con be made in » rumber of different ways, including wsing the [ntarsection of two
planeson1

{7 Repoats selected sketch entities, features, of components in an anay, which can be
linaar, circular, or sketch-driven

("""} Wien there are not enough dimensions and relations to prevent entlties from
moving ar changing size

11, What s boss In SolidWorks? 1 oy
Mark only ane oval.

{) Hat constructlon geometry; can be used for a 2D sketch, section view of a medel,
#nd otherse tool that hollows ot a part

) A faature thal cresies 1he base of @ pert, or adds material 10 2 part, by extruding,
revolving, sweeping, of lofting a skelch, ar by thickening & surface

) Atesture 100l that hollows out a part

12. Whatis chamfer? 1 paink
Mark only one oval,

{7 AnIntervsal rounding of a comer or edge in a sketch, or an edge on a surface o
soild

(") The 3D solid g ry in a part or bly d

{7 Bevels 3 selecied edge or vertex

Ftolingn ganche |, KHYZaF and
310112022, 16:23 Vakuo Adder! Coure
25.  Which lines on a drawing should be the thickest? 7 poinG
Mark only one oval.

C:) Dimenaion Lines
{5 Center Lines

26.  Which tool makes the object into a 3D part after you've completed the 1 point
sketch?

Mark only one oval.

(3 Line Tool
-

{75 cut Toof
3 Extrude Tool

27, ABQSSona3DPartls 1 point
Mark only one oval.

{3 Aboss must be a Reclangular Part
{1 Any featute connected te the main body of the 3D part

28, The drawing units in Solid Works can be changed from matric sizes to 1 pont
Inches,

Mark only one oval.

e

() False

= ¥ 1 ]



012022, 1625 Vakio Added Counse
6. A Ttture that removes material from part?

3% only one oval,

7. Re#2Mnships that align and flt components together in an assembly?
Mes#Xonly one oval,
7 Jvan

D Mate

N DComponsnl

8. Acelltcion of frequantly used commends callod?
Mark Oly one oval,

73 Menubar

9. What I8assgmbly?
Mark ofly one oval.

0 Aticument In which parts, léatures, end other pleces ars mated together
» The First Solid Festure of a Part, Created by o boss

{0 AL lationzhip, such as cof
Betvr 2€0 parts in an assambly

I tdnge e cominerid 1LKBOR K JCed 5

12022, 1623 Moo Arded Cowso
21, Which ofthe Following communicates the size of an object?

Mark only one oval.

. Bimension

22, Vigw that lets you ook at the assombly as if you took a saw and cut it
open,

Mark anly one oval,
{7 Assembly View

{27 section View
") Tool View

23, Afile where you combine parts together,
Mark oniy one oval.
et
|”) Assembly
‘) Drawing

24. Which view should show the most detail of the object being drawn?
Mark only one oval,

LI Top View
{7 Front View
(.3 Right View

, perpendi , tangent, and o on,

1 paam

1 paoing

1 pore;

7 it

1 pant

1%

02022, 1823

Vo Added Course
13.  What is origin?
Mark oniy one oval,

3 The point of intersection of the three defaut refecence planes

1 oot

I Asingular location in o skatch, or 8 projection Into a sketch at 5 singie location of

anaxternal ity
{__}Asingle 30 object made up of features

14, Unlike an extruded feature, & swept feature requires at least two sketches, 1 pont

Whatare they?
Mark only one oval,

(__J Top and front view

{3 Exit skatch and smart dimension

15, Whatls the minimum number of profites required for a loft feature?

Mark only one oval,

16.  Aleft blends multiple profiles together.

Mark only one ovel.

310172022, 96:23

Vilun Added Course
29.  What are the three standard views we show on our drawings?
Mark anly one oval,

{_.}op, fronk, Ieft
{7 top, frant, right
! left, right, top

Section2

30.  Whichis NOT an end condition for an extrusion?
Mark only one oval,

(M:) Up to Line
D uptoody
3 Up to Vartex

3T, Whenyou start a new sketch, what sketch typas do you select from?

Mark only ane oval.

{._.J 3D Sketch and Front Plane
" Sketch and 30 Sketch
£} Sketch and Block

32, Which feature do You use to creste & tapped hofe?

Mari only one oval,

{ > Extruded Cut
) Swept Cut

ro—.

3 Hole Wizard

e
1 pran;
1 pesnt
¥ it
1 point
*14



W02, 1623

Vaiue Addod Coune
33, Which K/¥board Shorteut allows you to view in full screen? 1 paint
Mark onf5Y e oval.
{ D
Rl
(TuA

34, While dig™ensloning, what causes all the dimensions to go yellow and an
error me#3%ge to appear?

Mark onf¥ tne oval.

) agedNg the wrong size
(T A& 15q many dimensione to the sketch {over-defined)
("3 No# énough dimension on the skelch

31012022, 1623

41,

42.

Ve Aded Courso

The Sketches Tab has all of the following tpols except which one? 1 pokit
Mark only one oval. 4.’

) Smert Dimenston

What is the correct comparison betwaen an Extruded (Revolved, Lofted, 1 point
Swept) and Extruded Cut (Revoived Cut, Lofted Cut, Swept Cut)?

Mark only one oval.

{3 An extruded feature adds materiat; an extruded cut divides the feature into equal
places

—

() An extruded feature adds il an extruded cut material
€™ An extruded feature adds material; an extruded cut hurts the material

35. Once yot! 3D apart, you CANNOT go back and change the sketch, 7 paint 43. You have to have one of these to sketch on. 1 i
Mark anfy one oval, Mark only one ovsl.
() mse (. Comer
Corase -l
(") Plane
36. If youbeghapart on the front plane, which axis usually gives the pbject 1 pat
depth or thickness? 44. 'When a part is created what do you need ta create to show someone else 1 pon
Mark onfy one oval how to build your object?
YK Axls Mark only one oval.
Y Axte () Crente an Assambly
(Dzaxh () treate a brawing
() irite ot descriptors with 19X an your object
Napxlitocs poogecnnisrmdd TUKRA_KHY [ g s grogin znmmi ZoF Abts A LsmiA e
HOUAR2, 1623 Yoo Adsied Coura =
45, If a featuretodl is not working what Is the most el issue? g . N
Mark only one oval, y ) ; \

{7 The sketch is niot fully defined | NP

() The sketich is not faeled properly

If you wanted to take your sketch and make it travel around an axds what 1 point
featuras tool would you use?

Mark only one oval.
() Revolved

Swapt

C....J Lofted

51. What are the most necessary dimeansions for a drawing that would be
included In almost every object?

Mark only one oval,

{7 Height, Widih, Depth
(7 Across, Width, Wideress

"} Helght, Width, Acrass

52. What tool would you use to round of f the comers of an abject? 1peint
Mark only one oval,

(2 Chamler
{2 Filet

P
{__Dome

itpa e guoglecomyTennEARTURFOC FHY EnFyClS R TR imFAR Yal s Ond St Ades 1214



3112022, 1625 Valua Added Course 0VAR2. 1623 Vatue Added Cowse

37, i YWhaye multiple parts and want to show how the parts fit together you 1 point 45.  What visual indication is there that a sketch is fully defined? 1 poat
m i ereste what,
Mark only one oval. B
MA%oniy one oval,

€7 Lines biink rapidly
< M drwing for avery part and look back and forth at each to see if it will work 7 Dimensions becoma yellow

An pseembly of many parts "} Lines become black

TN
{7~ Draw everything in one part rather then multiple parts

38, W Nskatehing what are the little green boxes with different symbols in 1 poit 46. To what shouid your first sketch be referanced to? 1 pons
the*Mcallad,
Mark only one oval.
Ms##Konly one oval,
- (> ongin
J Relations

D mais
./ Mates {__) Centerline

Cj.:\ Identitying Markers

47.  Once you are finished with your sketch the next stepistoclick onwhat? 1 poax
39, Wivatare thin lines alterniating long and short dashes used to degignate

cerstins of holes arcs, and other symmetrical objects? Mark only one ovsl,

MarKunly one oval, ("4 Features Yab

et
ey {_J Exil Sketch
{ i Dimension linex (- et

Hidden lines

" Stenter lines

48.  If you had crested multiple planes with esch plane having 8 different 1 paint
sketch, and you wanted to connect all of the sketches tagether as are

40.  Inars Assembly what tool should be used to create connections between 1 paint feature what features tool would you use?

different parts?
Mark only one oval.
Mark only one oval.
{7 Revolved
(o swept
Lokt
mmwmlum : s 3 W ' 124

012022, 1823 Vidio Arxdod Courno
53. Yo begin a sketch in SclidWorks the first thing you must do is? 1 poing
Mark only one oval.
(s Dimension the lines
(..} Create a set of paints that the lines will go through

J Sélect the plane that you will draw on,

§4.  Inan Isometric drawing whay. angle is used to draw the height of an 1 pownt
object?

Mark enly one oval.

7130 Degress .
i

{7} 60 Degrees

{190 Degrees

Thie content is neither cxativd nor eudorsedt by Geogs.

Google Forms
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Valuez Added Course SolidWorks Feedback Form

Excel Eng?*™¥ing Callege (A ), 0 of Mechanica! ing
* Required T .
1. Emafl"
Section1
2. Name*
3. Roll Nuretber®
4. Departrsont*
5. Yesr*
Mark onfy one oval,

i ko googte comtnmms A rhiustiiut 5 _ MotV n Cousiiibice_Donubprec:

IOV, 20 M Vaalum Addent Coimne Golidorkn Eradnssh Fom
10.  Did the tnstructor do an effective job of presenting the material? *

Mark only one oval.

U 1. How much this course was useful from the knowledge and Information point of

view?®

#dark only one oval.

Very Low

Tz conderst ks naithes crzatind ner endorsed by Soogle,

Google Forms

it M (rsagie

311012022 2038 Valt

6, Section*
Mark only one oval,
A

N—

-l

Section 2

7. How useful did you think this course for you? *
Mark only ene oval,

1 2 3 4 5

s s ey e

Verylow 7 7 7T 7Ty (TN Very Good

8. Did you recelve all the Informatlon you required? *
Mark only one ovesl.
{7 Yes
{INo
) Maybe

9. Where the contents delivered was helpful to you? *
Mark only one oval,

{ ) ves
{C ONe
7 maybe

a3

i}



SolidWorks Certificate Course Feedback Responses

How much this course
How useful did you |Did you receive all the |Where the contents Did the Instructor do an |was useful from the
Name Rofl Number  [think this course for |Information you delivered was helpful to |effective job of knowledge and
you? required? you? presenting the material? |Information point of
view?
Gautam Kumar 19MEQ30 3 No No No 3
Dinakaran 19ME025 4 Yes Yes Yes 4
Roshan Kumar Sharma 19MED76 3 Maybe Mavbe Maybe 3
P.Dinesh 19ME027 5 Yes Yes Yes 4
gﬁggﬁ,g” KOMAR 19ME083 5 Yes Yes Yes 5
DINESH KUMAR.S 19me028 4 Yes Yes Yes 4
o s 19ME029 5 Yes Yes Yes 5
HARIPRASATH 19ME036 5 Yes Yes Yes 5
m. balaji 19me016 5 Yes Yes Yes 5
S.SARABQJI 19ME081 4 Mavbe Mavbe Yes 3
Gulshan kumar Thakur 19me034 5 No Yes Yes 5
Deva.K 19MEQ22 4 Maybe No Yes 5
M.Kanagarai 19ME040 5 Mavbe Yes Yes 3
Dildas p b 19ME023 4 Maybe Yes Yes 4
Ashutosh Kumar Yadav 19ME014 5 Yes Yes Yes 5
Samir Akhtar 19MEO78 5 Yes Yes Yes 5
Vinay kumar 19MEQ95 4 Maybe Yes Yes 4
K.Santhakumar 19MEO80 1 Yes Yes Yes 1
Akhil kumar A 730919114003 5 Yes Yes Yes 5
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SolidWorks Cerlificate Course Assessmant

What is assembly?

What is axis?

“Dnns in an assombly

coincident,
perpendicular, tangent,
&nd so on, batween

of a Part, Created by a
boss

paris, features, and
other pieces are mated
togelher

parts, fsatures, and
other pieces are mated
together

parts, {eatures, and
alher pieces are mated
together

of a Part, Created by a
boss

parts, features, and
other pleces are mated
(logelher

M Kanagaraj M. Madhanraj HARIPRASATH Gautam Kumar Vinay kumar Barath |Roshan kumar sharma lemz‘ESAN s
1MEQ40 19MED4T T8MED36 1ERGEDS0 19MEDSS 18meli? ng.ﬁE_D?ﬁ 1GMEDSRS
207 60 17750 30750 25160 47 1 50, 201 50] 47150 38/ 50
:1;;'::: :'1:5::“_‘1%’ Boss Boss Boss Boss Boss Boss Boss Bass
es
:‘;f::;'fﬁ::‘;ﬂf’ Boss Boss Boss cut cut cut cut Cut
| Ralationships \hat 149"
f;;: E:;_o;' zﬁnents Component Component Mate Mate Mate Part Mate Mate
assembly?
i il
(ilecton W 3 |Menubar Toolbar Toalbar Toolber Toolbar Toalbar Toolbar Toolbar
A gaomelric
relationship, such as The First Solid Feature A documant in which A document in which A document in which The Flrst Solid Feature A dacument in which A document In which

parts, fealuras, and
other pieces are mated
togather

When there are not
enough dimensicns and
relations lo prevent
entities from moving or
changing size

enfities, features, or

which can be linear,

Repeals salected skelch
components in an array,

circular, or sketch-driven

A straight line ihat can
be used to create model

A straight line thal can
be used o creale mods|

A slralght line that can
be used 1o create model

geometry, fealures, or
patterns. Can be made
in & number of different
ways, Including using
the intersection of two
planeson 1

try, feal , or
patlerns. Can ba made
In a number of different
ways, including using
the intersaction of twa
planeson 1

Y. fealures, or
pattemns. Can be mads
in a number of different
ways, Including using
the intersection of two
planason 1

When there are nol
enough dimensions and
re(ations to prevent
enlilies from moving or
changing size

geomelry, (eal
patterns, Can be made
In a number of different
ways, including using
the intersection of lwo
planeson 1

A stralght line that can
be used to create model

A slraight line \hat can
be used Lo craate model

, or

c Y. or
pattams. Can be made
in & number of different
ways, including using
the Inlersaction of iwo
planesen 1

What is boss in
4 ‘arks?

e

Fiat construction
geometry; can be used
for a 2D sketch, saction
view of a model, and
olherse ool that hollows
outa part

A feature thal creates
the base of a part, or
mdda materal to a part,
by extrutfing, revolving,

|sweeping, or lofting a

skelch, or by thickening

L‘I suidface

Flaf construction
geometry; can be used
for a 2D sketch, section
view of a medel, and
olherse tool that hollows
oul a part

A lealure lhat creates
Lhe base of a part, or
adds material to a part,
by extruding, revolving,
sweeping, or lofting a
sketch, or by thickening
a surfage

A feature that creates
tha base of a parl, or
adds malerial to a par,
by extruding, revolving,

|sweeping, or lofing a

skaich, or by thickening
a surfaca

Flat construction
gecmatry; can be usad

vigw of a model, and
atherse tool that holiows
out a pant

A fealure thal creates
the base of a part. or

N wdds malerial 1o a part,
for & 2D sketch, section by extniciiag, revolving,
swesping, or lofling a
sketih, or by thickening

[

A teature trat creales
the base of a parl, or
adds malerial to a part,
by extruding, revolving,
swesaping, or lofting a
skaich, or by thickening
8 surfaos

3 T An internal rounding of a An intemal rounding of a
What is chamfer? th: 30’:;":&2:::“}' i.lr;h: 3::::':;2%?"" corner or edge In a Bevels a selectad edge |Bevels a selecled edge |comer or edga In a Bovels a selected adge |Bevels a selected edge
BB EEIiEy docu‘: i ¥ doch:n o0 4 sketch, or an edge on a |or vertex of vertex skelah, or an edge on a |orveriex or vertex
sutface or salid suiface of solid
A single 3 object made The point of intersection | The point of interseslion [ The point of Intersection | The painl of intersection The point of intersection | The point of inlersection
Whal is origin? I or;%eatu - of the three default of the three default of Ihe three default of the three dafault (blank} of lhe thrge default of the lhree defaull
P reference planes reference planas rafarence planes reference planes reference planes reference planes
Unfike an axtruded
:z:::::'s:tsl\::sp: ::;lurs Top and front view The sweep section and |The sweep section and |The sweep section and |The sweep section and [The sweep section and | The sweep section and |The sweep section and
| th h h
| skeiches. What are the sweep path the sweep pa the sweep pal the sweep path the sweap path lhe sweep patl the sweep path
1hay?
What is the mimmum
number of profiles 2 2 2 3 2
| reuirad for a faft 5 4 2
leattine?
Aloft Blands midliple, (7 TRUE TRUE TRUE TRUE FALSE TRUE FALSE
profiles toaethar,
Alofi feplure canba'a gy e TRUE FALSE TRUE FALSE FALSE FALSE TRUE
jboss anlv.
‘You can mirmor entities Falss. only 5
8 , only lines and False, only lines and False, only lines and
using reference planes |poc can be crealed | TRVE Edges can be craated | ROE TRUE Edges can be created | F [TRUE
and planar faces,
Which is a nol 3 \ype-of
paltern in Continuous pattemn Conlinuous pattern Continuous paltern Confinuoirs pattem Continuous paltern Table driven Pattern Conlinuous pattern Sketch driven Pattemn
SOLIDWORKS?
Which lool would you
8@ to cul a hole Extruda tool Extrude tool Extrude Cut lool Exirude Cut tool Extruda Cul tool Extrude Cut tool Extrude Cut tool Extruda Cut tool
throudh tha ohlect?
Whic™ = tha Following
‘cates the size |Dimension Format Dimenslon Dimension Dimension Dimension Dimension Dimension
\l"l'a'\;v that lets you loak
atthe assembly asit oo o viow Tool View Section View Saction View Saction View Seclion View Seclion View Section View
you took a saw and cut
it opan,
A file where you . bl
psirbIAg pats togathar. Drawing Drawing Assembly Assembly Assembly Part Assembly Assembly
Which view should
show the most detail of |Front View Front View Froni View Fronl View Front View Frant View Front View Right View
Ihe object being drawn?
Which lines an a
drawing should be the  [Cenler Lines Center Lines Object Lines Cantar Lines Object Lines Dimenslon Lines Objact Lines Oiiject Lines
|thickesr?
Which toal makes the
obfectintoadD pant i yog Line Tool Extrude Too! Extruds Tool Exirude Tool Extrude Tool Extrude Tool Extrude Tool
aftar you've compleled
the sketch?
Any feature connected [Any feature connected |Any feature connected |Any festure connected Any fealure connedted i ¥boss hhsthola Any lealure connected  [Any feature connecled
A BOSS on a 3D Part s |In the main body of the |to the main body of the |to the main body of Lhe  |ia the maln body of the {1a the main body of the e g to the main body of the |la tha main body of the
a0 part 30 aart 3Dpart 30 part 3D part g 30 part 30 part
The drawing units in
Sold Works canbe  ew sg TRUE TRUE FALSE TRUE TRUE TRUE TRUE
changed from melric
sizes 1o inches.
Whatare the three .
standard views we show|top. front, right top, front, right fop, front, sighl top, front, lefi fep, front. right top, franl, right top, fronl, right top, front, right
o0 our drawings? =
Which is NOT an end
conditlan for an lip o Verlex Up to Line Up to Line Up to Body Up to Line Up to Body Up lo Line Up to Line
xirusion?
When you starta new T
sketch, What SKSICh lquioh and 3D Sketcn  [3D Sketchand Front g\ 21430 Skelch  |Skatch and 3D Sketeh | Sketch and 3 Sketch 3D Sketch and Fronl | o1 and 3D Sketch | Sketch and 3D Sketch
types do you select Plane lane
fram? ~=




Which feature da you
use to creale g I.annnd’
hola?

Which Keyboard
Shortcut allows you to
view I full soreeny
While dimensioning,
whal causes alt the
dimensions to go yallo*
and an error message 1
appsar? —
Once you 30 a par, ye?l
CANNOT go back and
change the sketeh,
If you begin a part on
the front plane, which
axls usually gives the
object depth or
lhickness?

—

Swapt Cut

Swept Cul

Swapl Cut

Swept Cul

Hoale Wizard

Hole Wizard

Hole Wizard

Hole Wizard

g

F12

F11

F11

F11

F9 Fi1

F11

Adding too many
timengions to the
shatch (over-defined)

Adding the wrong size

Adding toe many
dimensions to the
skelch {over-definad)

Nol enough dimension
on the sketch

Adding oo many
di ions to the

Adding toc many
di i to the

skelch (over-defined)

skelch (over-defined)

Adding too many
dimensions to the
sketch (over-defined)

Adding too many
dimensions 1o the
sketch (over-defined)

TRUE

TRUE

|FALSE

TRUE

FALSE

TRUE

FALSE

FALSE

X Axis

X Axis

X Axis

Z Axls

X Axis

Z Axis

Z Axis

Il you have mullipa
paris and want to show/
how the parts fit

together you must
lucma what. =
When sketching what
#re Ihe dittle grean

boxes with differant
symbois in them called.

An Assembly of many
Parts

A drawing for every part
and look back and forih
at each to see if il will
work

Draw everything in one
parl rather than multiple
parts

(blank)

An Assembly of many
pars

A drawing for every pant
and look back and forth
at each 1o sees if it will
wark

An Assembly of many
parls

A drawing for every part
and look back and forih
at each to see if it wil
work

Malos

Identifying Markers

Mates

Idanlifying Markers

Ralations

Identifying Markers

Relalions

Mates

Wizt are thin finas
alternating long and
short dashes used (o
designalza centers of
holes arcs, and other
symimstrical objacts?

Center tines

Hidden fines

Hidden lines

Dimension lines

Cenler lines

Hidden lines

Cenler lines

Center lines

In an Assambly whal
too! should be used to
create conneclions
belween different parts?

Mate

Conneclion

Relations

Relations

Relations

Mate

Mate

all of the lallawing tools

The Skelches Tabhas |

Ling

Smart Dimension

Smarl Dimension

Smart Dimension

Revolve

Smart Dimension

Revolve

except which one?

What is the cormect
camparisan belwaen an
Extruded {Revolved,
Lofied, Swept) and
Extruded Cul (Revolved

An exiruded feature
adds material; an

extruded cut burts the

Cul, Lofled Cut, Swept
| Cut)?

An extruded feature
adds matertal; an
exlruded cut removes
malerial

An extruded fealure
adds material; an
extruded cul removes
material

An exlruded fealure
adds matenal; an

extruded cut divides the
feature Into equal pieces

An extruded feature
adds malerial; an
extruded cut removas
material

An extruded fealure
adda malerial; an
extruded cut divides the

An exiruded feature
adds materlal; an
extruded cut removes
Teature Into equal pieces |material

An exiruded fealure
adds malerial; an
extruded cut divides lhe
fealure inlo equal piaces

thesa 1o skatch on.

You have 1o have ong of Kl

Axis

Axis

Plane

Plane

Plane

Plane

Plane

When a part is created
whit do you need to

sise how to build your

object?

creata to show someone | Create a Drawing

Create a Drawing

Creats a Drawing

Creale an Assembly

Create a Drawing

Create a Drawing

Create a Drawing

Create a Drawing

Whal visual indication ls
there that a sketch is

fully definad?

Dimansions become
yellow

Dimensions become
yellow

Lines becoms black

Lines blink rapidly

Lines become black

Dimensions bacoma
yellow

Lines become black

Lines become black

To what should your first
skatch be referenced
o7

Axis

Axis

Axis

Axis

Origin

Origin

Origin

Origin

Once you are finlshedd
wilh your sketch the

nexl slep is o click on
whal?

Exit Sketch

Features Tab

Done

Exit Skelch

Exil Skefch

Fealures Tab

Exit Skelch

Done

1T you had croeated
multipla planas wilh
aach plane having a
different sketch, and you

{he sketches logether as.

ona fealure what

features Lool would you
a7

wanted to connect all of |Loft

Swept

Swapt

Swept

Loft

Swept

Loft

Swept

If & faature lool is not

There is an error n the

Thare Is an arror In the

The skelch is not

The skeleh Is not fully

Thera is an ercor in the

There is an error in the

There Is an arror in the

Thare s an error in the

whint features lool would
you ugse?

'Ww“ﬁg;hi‘:::iw skelch skatch labeled properly defined sketch skelch skelch skefch
If you wanted to lake

yaur sketch and make It

travel around an axis Swept Swaept Swept Swept Swept Revolved Swept Lofted

What are the mast
necessary dimensions
for & drawing Lhat would
be included in almost
eV et ?

Height, Width, Depth

Height, Widlh, Deplh

Helght, Width, Depth

Height, Wlidth, Depth

Heighl, Width, Deplh

Height. Width, Dspth

Height, Width, Deplth

Height, Widlh, Depth

What lool would you uss
to round off the corners
of an object?

Ta begin a skotch in
SolidWerks the firsl

1hing you must do 87

In an lsematric drawing
what angle Is used lo
draw lhe heighl of an

|obiect?

60 Degrees

Dome Fillet Fillet Chamfer Fillat Doma Filtat Fillet
Creale a set of points | Creats a set of points s
9 N . s p . elecl lhe plane that 3 L . Select the plane lhat Select the plane fhat
Dimension the lines that the lines will go that lhe lines will go (blank) Dimension the lines . a
fhrough thaiigh you will draw on. you will draw on. you will draw on.
30 Degrees 60 Degrees 60 Degreas 90 Degrees 30 Degrees 90 Degrees 30 Degress
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ENGINEERING COLLEGE
E)‘/‘Cé’ Komarapalayam-637303

DEPARTMENT OF MECHANICAL ENGINEERING
ACADEMIC YEAR: 2021 -2022
Indirect Assessment of Program Outcomes & Program Specific Outcomes
through Curricular and Extracurricular Activities

o L

Student Name : k- ®E\IH Date: 2\ )ol J20o>
Batch 12p\9-~20232 Year/Semester: |1)/
T'ype of Activity: Value Added Course —SOL1 D wowlee _—.

Provide your level of attainment for the following questions by SELECTING in the [] given,
[3/2/1 Indicates Level of Attainment; 3 — Very Much, 2 — Moderate, 1 - Some Extent]

1. Does this Activity/ Course improve your Technical Skill?
3 A 2 [] 1]
2. Does this Activity /Course improve your Problem Solving Skill?
30 2 [0 1EN e
3. Does this training / Course improve your practical Exposure?
3 [ 2 [ 1[]
4. Have you learnt any modern tools through this activity/ training?
Yes T No I if yes name of tool oot Wworl®
5. Does this activity /training useful to improve your professional ethics?
30 2 1£7)
6. Does this activity /training useful to apply for any modern research programs?
3 2 [ 1
7. Have you got any ideas to improve our environmental & social needs?
3 [] 2\ 1]
8. Have you ever felt that your communication skill & leadership skill has been improved
through this activity?

3. 2 1[]
9. Does this Activity / training useful to improve learning attitude with zeal?
3 2 ] 1]
10. Does this Activity /training useful for you to work in multi-disciplinary team?
3 [ 2.7} 1]
11. Does this Activity /training improve your mind to face any changes in your life?
3 & 20 1

Any other Comments:

[
Signature



& | ENGINEERING COLLEGE
E)‘/ce’ Komarapalayam-637303
DEPARTMENT OF MECHANICAL ENGINEERING
ACADEMIC YEAR: 2021 - 2022
Indirect Assessment of Program Outcomes & Program Specific Outcomes
through Curricular and Extracurricular Activities

————

Student Name : M - BALAT! Date: 2)[0l |22 2
Batch 1 90 -2023 Year/Semester: E
Type of Activity: Value Added Course -S0) | D WOTIR

Provide your level of attainment for the following questions by SELECTING in the [] given,
[3/2/1 Indicates Level of Attainment; 3 - Very Much, 2 — Moderate, 1 — Some Extent]

1. Does this Activity/ Course improve your Technical Skill?
30 2 1 1]
2. Does this Activity /Course improve your Problem Solving Skill?
3 2 [ 1[N
3. Does this training / Course improve your practical Exposure?
3_P) 2 0 10]
4. Have you learnt any modern tools through this actjvity/ training?
Yes (1 No [A"  ifyes name of tool _Solisl woytls
5. Does this activity /training useful to improve your professional ethics?
3 [ 2.1 1]
6. Does this activity /training useful to apply for any modern research programs?
3 2 [ 145
7. Have you got any ideas to improve our environmental & social needs?
3 [ 2 [ . 1A
8. Have you ever felt that your communication skill & leadership skill has been improved
through this activity?

3 [ 2 [h 1]

9. Does this Activity / training useful to improve learning attitude with zeal?
3N 2 [] 1]

10. Does this Activity /training useful for you to work in multi-disciplinary team?
30 2 [ 11

11. Does this Activity /training improve your mind to face any changes in your life?
3.1 2 [] 1]

Any other Comments:

W@Zﬁ-ﬂ’
Signature



& | ENGINEERING COLLEGE
E}(éel Komarapalayam-6373(g
DEPARTMENT OF MECHANICAL ENGINEERING
ACADEMIC YEAR: 2021 - 2022
Indirect Assessment of Program Outcomes & Program Specific Outcomes
through Curricular and Extracurricular Activities

.....

Student Name : DINAKARAN Date: 3)[0)) 2022
Batch : Q2B 20|9-23 Year/Semester: _T_ﬁ/

TYype of Activity: Value Added Course —SoLIDWORKS

Provide your level of attainment for the following questions by SELECTING in the [] given,
[3/2/1 Indicates Level of Attainment; 3 — Very Much, 2 - Moderate, 1 — Some Extent]

1. Does this Activity/ Course improve your Technical Skill?
3 2 [ 1]

2. Does this Activity /Course improve your Problem Solving Skill?
30 2 [ 17"

3. Does this training / Course improve your practical Exposure?
30 2 ¢ 1]

4. Have you learnt any modern tools through this activity/ training?
Yes €T\ No [ if yes name of tool _Selid twsnlce

5. Does this activity /training useful to improve your professional ethics?

3 [N 2 ] 1

6. Does this activity /training useful to apply for any modern research programs?
3 [ 24 1]

7. Have you got any ideas to improve our environmental & social needs?
3 2 [ 14

8. Have you ever felt that your communication skill & leadership skill has been improved
through this activity?
3 En 2 1 1]

9. Does this Activity / training useful to improve learning attitude with zeal?
3 2.4 10

10. Does this Activity /training useful for you to work in multi-disciplinary team?
34 2 [] 1[]

11. Does this Activity /training improve your mind to face any changes in your life?
30 21 1.

Any other Comments:

Ot

Signature
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Accredited by NBA, NAAC with “A*” and Recognised by UGC (2f &12B)
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EXCEL ENGINEERING COLLEGE

Department of Mechanical Engineering

ONLINE CLASS TIME TABLE
Academic Year: 2021-22 Year/Sem : IV(A)VII
Venue: CAMU Platform Ver: |
Session
' Jro2oam| 2 [vtzeam| % vooem| 4 | qaopm. | O
DAY/TIME 9.30AM- | 10.30AM | 10.30AM- | 11.30AM | 11.30AM- | 12.30PM | 12.30PM- | 2.30PM | 2.30PM-
10.20AM 11.20AM 12.20PM 1.20PM 3.20PM
MON ce CC CcC CcC PW
TUE CC CC CcC CC PW
WED cC cC cc ceC PW
BREAK BREAK BREAK LUNCH
THU cC cC CC CC PW
FRI Project Project Project Project Project
Review Review Review Review Review
Course Course Name Acronym | No of Hrs Faculty Name with
Code Credits Designation/Dept.
. . Mr.V.Udhayakumar ,AP/Mech &
ME 8811 | Project Work & Review PW 10 9 Project Co ordinators.
B Certificate Course on CNC ce ] 16 Dr.A Karthikeyan ,ASP/Mech
Programming Dr.N.Tamilselvan ,AP/Mech
S.No. Name of the Mentors
1 Mr.V.Udhayakumar ,AP/Mech , (Chief Mentor)
2 Mr.S.S.Jayaraman ,AP/Mech
3 Dr.N.Tamilselvan ,AP/Mech

Department TT coordinator

B M Qﬁ}\af\/

HoD
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EXCEL ENGINEERING COLLEGE

(Autonomous)
Approved by AICTE, New Delhi & Affiliated to Anna University, Chennai
Accredited by NBA, NAAC with “A*” and Recognised by UGC (2f &12B)

KOMARAPALAYAM - 637303
Department of Mechanical Engineering

ONLINE CLASS TIME TABLE
Academic Year: 2021-22 Year/Sem : IV(B)/VII
Venue: CAMU Platform Ver: 1
Session
' l1020am-| 2 |q120am| % 1220w | 4 | 130Pm- | B
DAY/TIME 9.30AM- | 10.30AM | 10.30AM- | 11.30AM | 11.30AM- | 12.30PM | 12.30PM- | 2.30PM | 2.30PM-
10.20AM 11.20AM 12.20PM 1.20PM 3.20PM
MON cC cC cC cC PW
TCE cc cc cC cc PW
ULy ccC | BREAK | cc | BREAK | cc | BREAK | cc | uncH | PW
L cc cc cc cc PW
FRI Project Project Project Project Project
Review Review Review Review Review
Course Course Name Acronym | No of Hrs Faculty Name with
Code Credits Designation/Dept.
: . Mr.T.M.Sakthimuruga ,AP/Mech &
ME 8811 | Project Work & Review PW 10 9 Project Co ordinators.
B Certificate Course on CNC ce i 16 Dr.A Karthikeyan ,ASP/Mech
Programming Dr.Vinoth, ASP/Mech
S.No. Name of the Mentors
1 Mr.T.M.Sakthimuruga ,AP/Mech , (Chief Mentor)
2 Dr.N.Venkatachalam ,ASP/Mech
3 Mr.M.Sambathkumar ,AP/Mech

Department TT coordinator HoD
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KOMARAPALAYAM - 637303
DEPARTMENT OF MECHANCIAL ENGINERRING
ACADEMIC YEAR 2021-22
CERTIFICATE COURSE FINAL YEAR
Programming on CNC LATHE AND MILLING

COURSE CONTENTS
Duration :Z0hrs
Lecture Descriptions
No
1 Introduction
2 Lathe Coordinate system & Operations
3 G & M codes
4 CNC lathe — facing & Turning operation
5 Step Turning operation
6 Taper & Step Turning operation
7 External Threading Operation
8 Grooving Operation
9 Drilling operation
10 Boring Operation
11 Step & Taper boring Operation
12 Internal Threading Operation
13 CNC Milling Coordinates & Operation introduction
14 Contouring operation
15 Pocketing operation
16 Drilling operation
17 Mirroring command
18 Discussion about process planning
19 CNC lathe and/u m

Coordinator HOD

20 MCQ.E EoRp WoR\
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— = EXCEL ENGINEERING COLLEGE
Lecture No Course Contents i DEP. ARTMENT OF MECH ANICAL
|
= . — . . ENGINEERING
CNC Milling Coordinates & Operation introduction
Contouring operation (linear) l ONLINE
Contouring operation (Circular) [ CNC MILLING PROGRAMMING
4 Contauring operation (letters) ’ CERTIFICATE COURSE
5 Pocketing operation
6 Drilling operation | Dr A.Karthikeyan
7 Mirroring command | Asso.Prof
§ __ICombined Bxercise Department of Mechanical Engineering
J___|[Frocessiplaniniig Excel Engineering College
10 Test
1 ; SN i SIRIE T
i . S —— —_ _\L—-Hm”‘._"“-—w—. s I
F— e
. PROCESS | QUTPUT | Computer Numerical Control
s z |
] ]
5 i
| |B INTERFACE @ | |
[] (]
! :
| e |
THE COMPUTER IS USED TO | LS FF | THE SIGNALS FROM THE :
INPUTTHE DESIGN. | commurer o paay ! INTERFACE CONTROLS G cods ,M Codes, Numbers
SOFTWARE SUCHASTECH | — THATTHE CNG 1 THE MOVEMENT OF THE G 94 X30Z100F 25
SOFT 1S USED TO DRAW | piscHINE CAN USE. THE!  CUTTING TOOL. THE G oo
THE DESIGN. THE [ INTERFACE IS | DESIGNIS G
COMPUTER CONNECTSTO | cONNECTEDTO THE |  MANUFACTURED ON THE ' oL
THE INTERFACE. : GNG MAGHINE |  CNC MACHINE. | M o3

i Mos S 3500
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CNC MILLING CUTTERS

A
A End i il Cu :
oughingEnd Mill SabMillCutter  EndMillCutter o dollow MIll Cutter
Wood Ruff Cutter i l Face Mifl Cutter

Thread Mill Cutter Fly Cutter

ot

Invalute Gear Cutter

Hobbing Cutter Dovetall Cutter  iife and Face Cutter

Advantages of CNC

Flexible, high accuracy

Short production time

Complex shapes

Short setting time

No skill requirement

Shortinspection time/ high quality product
(Qw CQst

Face Milling

Prafite Milling

Stut Mnl!hg

Pecking / Drilling /
Threading / Reaming

Pocket Milling

Engraving

by Eniia Gandarias




Disadvantages of CNC

High machine cost
Complicated maintenance

Skill & training are required for programmi

and maintenance.

Parts are imported from aboard.
High tooling cost

Temperature, humidity & dust must b
controlled.
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] J

EXCEL ENGINEERING COLLEGE {AUTONOMOUS)
Affiliated to Anna University, Chennai. Approved by AICTE, New Delhi

Pallakapalayam, Komarapalayam, Namakkal Dt.-637 303

Value Added Course

\ L Ty}
\

N Bl

2 ~ 3 s \ AT \\
S.NO Register No Name N ' il eV 1T gatlgaly i
1 730918114001 AASHAP SOLOMON K [2001-03-07] sl 21 -V al /YK 717
2 730918114002 AKASH K [2000-05-04] 177 Vit lol, l@&l7
3 730918114003 AKSHAY R KUMAR {1999-11-12] RIAVEVEVEFEVEVE A
4 730918114004 ANBARASU A [2000-10-31] et | 7 1,0 |27 87 |7 7
5 730918114005 ANBARASU A [2000-12-31] s iz V2V, /0 |7 0 Tals
6 730918114006 ANISH KUMAR R [2001-03-17) A VAENVEIR VA TSR IEYy:;
7 730918114007 AL ANOODH AFSAL [2000-07-08] A VYAVAVARRNYZE DR W Ve >
8 730918114008 ARAVINTH R [2001-06-03] B VEPEEFFN AV EVE TV L
9 730918114009 ARAVINTHAN M [2001-07-19] EVEVE R VZNrIrEY, s la
10 730918114011 AYUSH KUMAR SINGH [2002-06-06] R VEAR VRS VEIETEY
1 730918114014 BHARATHRAJ R [2001-06-08] ris ol 1,0, T 81,1,
12 730918114015 CHANDRU S [2001-08-09] cdovls Vrlal/zZ Y, lals
13 730918114016 CHRISTO JOHN EMMANUEL [2000-07-13] atr vzl 1,0, T/ Ta
14 730918114017 DEEPAN B [2000-05-17] s 17 rlal loalrel, Tals
15 730918114019 DEEPAN RAJ M [2000-04-02] /s N, 02020 o1, 24 171/
16 730918114021 DHANAPAL A [2000-12-21] A VA VA v vl 2N Vil IV e
17 730918114023 DHEENADHAYALAN K [2002-03-31] rials b2 0, la by, (2107
18 730918114024 DHEVAN V [2001-01-18] VAR AN A VR VRS 7
19 730918114025 DHINAGARAN G [2001-06-02] = VRV YAVE A VR VELd =
20 730918114026 DHINAKARAN S [2000-04-10] cd o 7 b7 o als balsl/
21 730918114027 DHIRAJ KUSHWAHA [1999-04-24] (Lo N2 00Nl Vo 7z 80 7217
22 730918114028 DINESH G [2000-10-11] b 1207 labzlzg 8, -0
23 730918114029 DINESHKUMAR S [2000-04-20] \» Nl 072 V2l B/ [Ty
24 730918114034 GOVINDARAJ § [2001-05-24] Al 1287217200, %17 la
25 730918114035 GOWTHAM S [2001-04-03] ol V2l 0,117
26 730918114036 HABIB DHUNIYA [1997-12-20] ~br |lrks &k, I, 0z 1717/
27 730918114037 JAGAN R [2001-02-20] A VACSVAE AN
28 730918114038 JUITHPRASANTH S [2001-07-07] 8/ W/ by, 1207 T/ B0,
29 730918114039 KALAIARASAN C [2000-10-16] cd7 o070 1) &, T 2icC
30 730918114040 KAMALAKKANNAN A [2000-11-27] o 2 1l7 1,080l T, 1,17
31 730918114041 KARTHEEPAN T [2000-12-01] Al 7201/ a7 0, Tal” s
32 730918114042 KARTHI E [2001-03-21] V707107 Ta T 27lal,
33 730918114043 KARTHICK R [2001-01-07] AN YRV Ve YR AEVEVA N
34 730918114044 MANIKANDAN K [2001-07-27] VAR al VAl V2 VAR AR VA IVE 14
35 730918114045 MANI PRAKASH S [2001-11-04] /V\r 7 L/ stz 7 1,1, la
36 730918114046 MANIVEL R [2001-08-21] Al IR 2l 2/ W17 07
37 730918114047 MANJAY KUMAR THAKUR [1999-02-10] atrlZ2Ziz /Al Tl 1r
38 730918114049 MOTIF ANSARI [1998-12-28] Cirlzlal W 707 1al,
39 730918114051 MUGHIL R [2000-03-05] ARSIV EVYaVEVEYEYEEr:
40 730918114053 NETHAJI S [2001-03-16] A VAR VEVEVEIEVAVREL
41 730918114054 NIRAJ KUMAR YADAV [1997-07-08] s |/ iz {al, 17 07107 7
42 730918114055 NIRANKUMAR HAOBAM [2000-03-07] oy | ri2 1, VR 37217 14
43 730918114057 NITHISHKUMAR N [2000-11-26] hrlz x|l |al/ o l7
44 730918114058 PANKAJ YADAV [1999-07-24] A VATrEYA T A R N
45 730918114060 PRABIN MAHATO [2001-09-22] Vel b2l b, M b/ )1, la
46 730918114062 PRASANNA KUMAR M [2001-04-10] Vo 1 AR, alre |l V7 |s
47 730918114064 PREMKUMAR S [2000-11-21] ~A 7 i,/ Tl -0 17
48 730918114068 RAJKUMAR S [1998-07-11] Aol YRV A 07 T i7 7 17
49 730918114069 RANJITHKUMAR P [2001-05-14] alzszlr sl 71v, 01, 0172014 1a
50 730918114070 RAMKUMAR S [2001-04-08] VN7V V200, T, 17
51 730918114074 SANTHOSHKUMAR G [2001-04-22] sVl lalr /20720, T/
52 730918114075 SANTHOSH KUMAR C [2000-05-03] lalz te |7l b1/ 1/
53 730918114076 SATHISHKUMAR M [2001-12-06] RVAPECAVET AR rErra
54 730918114080 SHANMUGAM N [2001-01-16] V17 Tal 7 [ad s, din
55 730918114081 SIVAKUMAR S [2000-09-17] al/ - 7 lalsl/ tals I/
56 730918114082 SUNDARESAN A [2001-03-26]- - Letorlodr |7 ialye i1/ 1
57 730918114084 UDHAYA KUMAR L[2000-12-09] 18lEEls il A% o |2 Ta 2T 77 &/ 1a
58 730918114086 VENGADESAN S [2001-06-07] TrwN - T 7121, 521, 1/
59 730918114089 VIJAY S [2001-06-03] - plAdE M i 2ol l7 1a]|” 17
60 730918114301 DHANANJEYAN S{1998-08-28:v,... ' |/ 1w'ls0o/ | 7 » | @ 7 |7 |-




b1 730918114302 GOKULAKANNAN R [1999-05-20] alsz7 1,1 lalesel sl Zlrq ¢
62 730918114303 IUTO Y SHOHE [1996-11-19] s by lals |, sl e s
63 730918114304 LOGESHWARAN S [2001-06-18] P e I V2 a5 AR VAl 4N B2 W
64 730918114305 NESTLINE ANTO JOHNY [1999-08-30] a7zl ta l”7 1, ¢ |7 |7 1 s
65 730918114306 SAM SABU [1998-04-13] ooty e V2 s V&) V72 [Pk
66 730918114308 SUDHAKAR S [1998-06-05] s o, VX1, 171257 1/ 8,
67 730918114309 VENKATESH G [1997-07-03] s Jalrs [C1L 7120 ~17 4y
68 730918114701 GOWTHAM M [2000-11-06] A by ls Ve l7rlalr i7 |/ ’
69 730918114702 MUTHUKRISHNAN R [2001-04-13] PEPEPEZE A AN ~ls Bl
70 730918114703 JAYA PRASANTH V [2000-11-04] sl V. &V 2172 07 |7 %
1 730918114704 VIJAY S [2001-01-07] sl lalalrlanls (72 |2 P
72 730918114705 MANIKANDAN R [2001-07-22] PEP AT A VAIR Y,
73 730918114706 BATHIRANKARTHI M [2000-11-16) a iJ |z ba |r L/ / i sla by
74 730918114708 ELANGOVAN E [2000-10-04] s | 7Y I/, 1alricslel,
75 730918114709 MADHANRAJ A [2001-03-07] Ltz lal”z |, | 2 %/ |, k.
76 730918114710 SANTHOSH V [2001-02-21] y b7 |7, |/ ¥ |2 57
77 730918114711 JANARTHANAN S [2001-07-25] s s aiz )l a s R72]al,
78 730918114712 KABILAN K K [2001-04-25] a ke |7 slalr | @ r e ’
79 730918114713 SANDHIYA B [2000-09-15) J o e Lr|l %, |7 2|l A0 7
80 730918114715 NIVED KV [2000-04-05] 7 k72 s 2|, Vo |y §-1 /17
81 730918114716 SIVAPRASANTH D [2001-07-12] Y |lalr 757 ol |2’
82 730918114717 VIKRAM N [2001-09-09] A bs s s laia |/ 7 |74 s
83 730918114718 MATHANKUMAR R [2001-02-25] /A 072 |l b7 |, ‘B
84 730918114719 BHARATHIRAJA M [2001-05-18] PEVEIVE-SLEYAVETIEIS Y
85 730918114720 BOOPATHI M [2001-06-06] s da laa sl i), Ial, 37
86 730918114721 VINITH S [2001-04-09] o 87 |7z 8 |7 87 la Bs s %~
87 730918114722 LOKESH J [2001-10-05] L, by 1s A Ks |7 de |, T
88 730918114723 VUISRI A [2001-03-03] e |, A2 Mo |V 87 |la 57
89 730918114724 NITHIN R [2001-06-26] 7 W, 0la sz 0| 87 |4 B4
90 730918114725 ABIMAN! P [2001-03-22] ; il A s [ 59|, 3,
91 730918114727 ARAVINTHAN C [2001-06-12] L4 | %o 87 |/ 37 |/ &7
92 730918114729 VASANTH R [2000-06-05] aly |87 z84 17 B |7 ¥/
93 730918114730 MUGESH KANNAN B {2001-06-24] /s 7 lad,lrbelr ¥, 1& 52
94 730918114731 MANOJKUMAR M [2001-04-12] ;A sis|ads |2 B 2 7
95 730918114732 PRANOOP P [2000-10-15] s 42 |ig BA|r By |¥ £ N0y
96 730918114733 VISHWANATHAN § [2001-04-03] o bes |, 87 |07 |y L {4 G
97 730918114734 MANIKANDAN R [2001-02-07] a7z |, 0, g &/ A § -1 8y
98 730918114735 SATHISH KUMAR S [2001-03-07] v hoc| sds |, & |7 §71 437
99 730918114736 JAYA KUMAR P [2001-02-01] yoir Loy |4 Y7 |y i%1, 2
100 730918114738 SHARANG N C [2001-01-06] s 22 7 87 |y |a fr |4 i
101 730918114739 SURESH C [2001-10-04] Ve s | Scir |2 U/ |7 27 X/
102 730918114740 RAVI KUMAR R [2001-06-25] s hal - Jrlad’s |7 5 |, 87
103 730918114741 VELMANI S [2001-08-15] als | 877 §4 17 et
104 730918114742 LAVANYA M [2000-11-10] Al Pl e 2 ) ¢t A Ls e K7
105 730918114743 PERUMAL D [2001-02-06) izl iz A TR EE
106 730918114744 THAVARAJ P [2000-02-29] / 2 %, |7 sV, Y207 §¢
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EXCEL ENGINEERING COLLEGE

(Autonomous)
Approved by AICTE, New Delhi & Affiliated to Anna University, Chennai
Accredited by NBA, NAAC with “A+” and Recognised by UGC (2f &12B)
KOMARAPALAYAM - 637303

CERTIFICATE CNC PROGRAMMING COURSE
FEEDBACK

IV YEAR (20.01.2022- 01.02.2022)

aKarthikeyan.eec@excelcolleges.com (not shared) Switch account

* Required
Name of student *

Roll No *

Howmuch syllabus covered ? *

80-100 %,60- 79%,40- 59%,below 40%
How the faculty members handled the class *
Effectively,Good,Average,Poor

How many classes you attended? *

more than 80%,60-79%,40-59%,below 40%
What is the code for inch *

B i

What is the code for reference position *

Pl

4|

What is the code for Non cutting movement *

Bl

ol |

What is the code for linear cutting movement *



1 i i
W_.;-»hi is the code for clockwise cutting movement *

-~

Py o

What is the code for multiple turning *

b

e _ﬁ'

What is the code for Groo
hd

Led ] ¥

What is the code for Drilling *

lat- s

What is the code for threading *
L | l / i =

What is the code for feed/ min *

e 2

What is the code for coolant on *

What is the code for tool change *




S

BN

What is the code for spindle off *

L] |

e

[E1IS

How many axis for lathe *

B 1

IS

How many axis for Milling *

(sl

g

sl

What is the code incremental method in CNC milling *
KEIES _*_I_‘

What are the operation in CNC MILLING *

-

e :




s%e Excel En~ineering College
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B8 completed the Certificate Course titled “CNC Programming on Lathe &
Milling ” successfully from to organize by Department of Mechanical
Engineering

A~/ 00 Namuep e —
Dr.A.Karthikeyan Dr.N.Natarajan
Coordinator Head of the Department
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& | ENGINEERING COLLEGE
E}(ce’ Komarapalayam-637303
DEPARTMENT OF MECHANICAL ENGINEERING

ACADEMIC YEAR: 2021 - 2022

Indirect Assessment of Program Outcomes & Program Specific Outcomes

through Curricular and Extracurricular Activities

Student Name : SA NTH-E\)'\ B Date: 331 / { (120

Batch

: NOIg42022 Year/Semester: [/ |

\
TYpe of Activity: Value Added Course ("N C ?Yﬁ‘w%

Provide your level of attainment for the following questions by SELECTING in the [] given,

[3/2/1 Indicates Level of Attainment; 3 — Very Much, 2 — Moderate, 1 — Some Extent]

1.

10.

11.

Does this Activity/ Course improve your Technical Skill?
3 2 [ 1]

Does this Activity /Course improve your Problem Solving Skill?

30 2 107

Does this training / Course improve your practical Exposure?

3 Qﬁ 2 [ 1]

Haveyu learnt any modern tools through this activity/ training?

Yes ] No [] if yes name of tool s nJ (v ot -

Does this activity /traiging useful to improve your professional ethics?

3 [] 2 1]

Does this activity /training useful to apply for any modern research programs?
3@ 20 1

Have you got any ideas to improve our environmental & social needs?

3 [ 2 [] 1

Have you ever felt that your communication skill & leadership skill has been improved

thrggh this activity?
3 2] 10

Does this Activity / training useful to improve learning attitude with zeal?

3 [ 2 1@

Does this Activity /training useful for you to work in multi-disciplinary team?

3 [] 2] 1

Does this Activity /training improve your mind to face any changes in your life?
30 2 [2 1]

Any other Comments:

B SonHAe

Signature



ENGINEERING COLLEGE
E)/Cé' Komarapalayam-637303

DEPARTMENT OF MECHANICAL ENGINEERING
ACADEMIC YEAR: 2021 - 2022

Indirect Assessment of Program Outcomes & Program Specific Outcomes

e

through Curricular and Extracurricular Activities

StudentName: DE EPAN - B pate: 31 [| 20490
Batch : 208 [ oo Year/Semester: [ \\y

—

TYype of Activity: Value Added Course ( (vC- P*%twﬂﬂ:v@é

Provide your level of attainment for the following questions by SELECTING in the [] given,

[3/2/1 Indicates Level of Attainment; 3 — Very Much, 2 — Moderate, 1 - Some Extent]

1.

10.

11.

Does this Activity/ rse improve your Technical Skill?

3 [ 2 1]

Does ;Irps Activity /Course improve your Problem Solving Skill?

3 2 1]

Does this training / Course improve your practical Exposure?
20 1 Z]”o

Have yo learnt any modern tools through this activity/ tralnmg?

Yes EI/W if yes name of tool (ny(" P_w_)wwmw

Does this activity /tralnmg useful to improve your professional ethics?

3 A/ 2 0 10

Does this activity /training useful to apply for any modern research programs?
3 0 2 &1 10]

Have you got any ideas to improve our environmental & social needs?

3 2 3 1]

Have you ever felt that your communication skill & leadership skill has been improved
through this activity? -

3 [ 2 0 174/

Does this Activity / training useful to improve learning attitude with zeal?

3 2 [] 1]

Does this Activity /training useful fo5 you to work in multi-disciplinary team?

3 [ 2 ] 1 i
Does this Activity /training improve your mind to face any changes in your life?

3 2 [ 1]

Any other Comments:

B fapeld

Signature



& | ENGINEERING COLLEGE
E)(ée’ Komarapalayam-637303
DEPARTMENT OF MECHANICAL ENGINEERING

ACADEMIC YEAR: 2021 - 2022

Indirect Assessment of Program Outcomes & Program Specific Outcomes

—

through Curricular and Extracurricular Activities

Student Name : 5\LA§H <K Date: | /l [no>2

Batch

: Q018{aogg\ < Year/Semester: /g 4oy

TYpe of Activity: Value Added Course e PQGX J %M‘g

Provide your level of attainment for the following questions by SELECTING in the [] given,

[3/2/1 Indicates Level of Attainment; 3 — Very Much, 2 — Moderate, 1 — Some Extent]

1.

10.

11.

Does this Activity/ Course improve your Technical Skill?

3 [ 2= 10

Does this Activity /Cgurse improve your Problem Solving Skill?

3 [ 2 7 1

Does this training / Course improve your practical Exposure?

3 =7 2 O 10

Have you learnt any modern tools through this activity/ training?

Yes 7T No [ if yes name of tool __ * M€ Do Coummn( 8k

Does this activity /training useful to improve your préfessional ethics?

3 0 2 10

Does this activity /training useful tg apply for any modern research programs?
30 2] 1

Have you got any ideas to improve our environmental & social needs?

3 / 2 [] 1]

Have you ever felt that your communication skill & leadership skill has been improved
through this activity?

3 O 2 O i d

Does this Activity / training useful to improve learning attitude with zeal?

3 ' 2 [ 1]

Does this Activity /training useful for you to work in multi-disciplinary team?
3 [ 2 &< 1]

Does this Activity /training improve your mind to face any changes in your life?

3 2 [ 1T

Any other Comments:

R’ Aleosh -

Signature



